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Overview
S-CONCRETE Enterprise edition (also called Multistory Designer), is a software solution that enables the
communication between an ETABS® model’s data and S-CONCRETE, allowing users to design reinforced
concrete Columns, Beams and Walls efficiently. Multistory Designer provides the means to run interactive
design/code checks on all concrete structural elements contained imported from an ETABS® model, and
generate a single comprehensive concrete design report.

Supported Objects 

The application supports the following ETABS® modeling elements. 

Two-Node Linear Members 

ETABS® Columns 

ETABS® members designated as Column objects can be imported and designed as S-CONCRETE 
Columns.  Only Rectangular, Square and Circular cross-sections are supported at this time. 

ETABS® Beams 

ETABS® members designated as Beam objects can be imported and designed as S-CONCRETE 
Beams.  Only Rectangular cross-sections are supported at this time. 

ETABS® Braces 

ETABS® members designated as Brace objects can be imported and designed as S-CONCRETE 
Columns and/or Beams as specified by the user in the application. Only Rectangular beam sections 
and Rectangular, Square and Circular Column cross-sections are supported at this time. 

Three/Four Node Area Objects 

ETABS® Piers 

ETABS® vertical shell elements designated as Pier objects can be imported and designed as 
S-CONCRETE Columns and/or Walls as specified by the user in the application. Only Rectangular Pier
cross-sections are supported at this time.

ETABS® Spandrels 

ETABS® vertical shell elements designated as Spandrel objects can be imported and designed as 
S-CONCRETE Beams.  Only Rectangular Spandrel cross-sections are supported at this time.

Floor/Story 

ETABS® Story labelling system is integrated into the application.  This provides the capability for the user 
to Group elements by a single Story/Floor or a user-selected list of Stories/Floors within the application to 
facilitate the creation of S-CONCRETE files that will be run in Batch to perform the concrete code 
check/design.   Member lengths, by ETABS® Story, are imported and utilized in the design for Columns, 
Braces and Walls.  These lengths can be included in the slenderness calculations for the members. 
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Load Combinations 

S-CONCRETE requires Ultimate/Factored loads for design. The user needs to perform the ETABS® analysis
with the desired Load Combinations and then import a selected list of Combos at the time the ETABS®
model and the results data are read into the application.   ETABS® Analysis forces for all active output
stations are imported and utilized in the design/code checks, and there is no ability to filter output
stations at this time.  However, the user can control output stations within ETABS® as an attempt to
obtain the required design forces on the members for the S-CONCRETE design.  Analysis forces for all
active degrees of freedom are imported and mapped to the S-CONCRETE section for design.

Data Filters 

The application supports the Filtering of ETABS® member data during the Import Model process.  For 
Linear Members, a filter for ETABS® Section Names can be utilized to limit the sections imported for the 
S-CONCRETE operation.  Similarly, for Wall Piers and Spandrel objects, a filter for Pier and Spandrel
Names can be set during the model import process.  As mentioned in the Load Combinations section
above, there is also a Filter for ETABS® Load Combos.  These filters allow the user to control which
elements of the analysis model and which forces are used by the application.

The ETABS® Import Utility 

In order to use the S-CONCRETE Enterprise Multistore Designer, you first need to export your ETABS® 
model and analysis results to a Microsoft Access Database file.  This procedure requires Microsoft Access 
2010 or greater to be installed on the computer that is running ETABS®.  The detailed steps to perform 
the Export are shown as follows: 
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Export a model to Access Database file in ETABS® 2015, 2016, V17 and V18 

1. Go to File > Export > ETABS® Database Tables to Access … 
 

 
Figure 1. Export to Access Database File 

 

2. To the right of the “Choose Tables for Export to Access”, you have the ‘Select Load Patterns…’, 
‘Select Load Cases…’, and ‘Select Combos…’ options.,  
 

 
Figure 2. Choose Tables for Export to Access dialog box in ETABS® 
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3. Select “Clear All” in Load Patterns and Load Cases sections, and select the Load Combinations you 
want to Export and use for Design in the Load Combinations section.  Then click OK. 

 

  
Figure 3. Choose Load Combinations to Export in ETABS® 

 

In the “Choose Tables for Export to Access”, check the “MODEL DEFINITION” object and all of the sub-
objects will be automatically selected.  In the “ANALYSIS RESULTS” object, expand “Results” and select the 
Frame and Wall results you want to export.  You only need to select the options for Column, Beam and 
Frame forces in ‘Frame Output’, and Pier and Spandrel forces in the ‘Wall Output’ section as shown below.  
Then, click OK. 
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Figure 4. Choose Members to Export in ETABS® 

The “Choose Export Units” dialog box will appear.   In this dialog box, select “Length Unit” as “m" (Meters) 
or “ft” (Feet).  Select “Force Unit” as “kN” or “Kip”.  Select “Temperature Unit” as “C” or “F”.  These are the 
only length and force unit combinations that are supported at this time.  Then click OK.   

Figure 5. Choose Export Units in ETABS® 
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The program supports: 

• Metric Units of Meter, kN, and C 
• Imperial Units of Feet, Kip, and F. 

Note: The “Choose Tables for Export to Access” dialog box shown in Figure 4 will close once the 
export is complete. Do not close it or click ‘OK’ again. It could stop the export process.  

 

Good to know: users are able to create their own ‘Named Sets’ of tables for Export to streamline the 
process. Please find below an example using ETABS®v18. 

ETABS® Named Sets can be defined via the Define Main Menu (as shown in Figure 6), or via the Model 
Explorer Tables Tab, as Table Sets (see Figure 7). Named Sets could be established in an ETABS® 
Template (starter) file which could then be used to create models. 

 

Figure 6. Creating ETABS® Named Sets 
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Figure 7. Named Sets Selection 

 

ETABS® defined Named Sets can also be used in the Automatic Tabular Export of Data option in the Set 
Load Cases to Run feature.  This method automatically includes pre-defined Named Sets in the export file 
created by ETABS®. 
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Figure 8. Automatic Tabular Export of Data for a set of Load Cases 
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Tables required when exporting to Access Database file in ETABS® V17 and V18 are shown in Table 1: 

ETABS® v17 ETABS® v18 

Model Definition Model Definition 

Frame Assignments - Sections Frame Assignments - Summary 

Frame Assignments - Summary Frame Section Property Definitions - Concrete 
Circle 

Frame Sections Frame Section Property Definitions - Concrete 
Rectangular 

Group Assignments Frame Section Property Definitions - Summary 

Material Properties - Concrete Group Assignments 

Material Properties - Summary Material Properties - Basic Mechanical 
Properties 

Pier Section Properties Material Properties - Concrete Data 

Program Control Pier Section Properties 

Spandrel Section Properties Program Control 

Story Data Spandrel Section Properties 

- Story Definitions 

Analysis Results Analysis Results 

Beam Forces Element Forces - Beams 

Brace Forces Element Forces - Braces 

Column Forces Element Forces - Columns 

Pier Forces Pier Forces 

Spandrel Forces Spandrel Forces 

Design Data Design Data 

Beam Design Forces Design Forces - Beams 

Brace Design Forces Design Forces - Braces 

Column Design Forces Design Forces - Columns 

Pier Design Forces Design Forces - Piers 

Spandrel Design Forces Design Forces - Spandrels 
Table 1. Tables from ETABS® required by the Multistory Designer 
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S-CONCRETE Enterprise Multistory Designer for ETABS® Application  

Sample Model-2: Steps to get a successful run in the Multistory Designer Application 

The ‘SampleModel2’ is a mid-rise building containing a concrete core modelled as vertical shell elements 
that also includes coupling (link) beams, reinforced concrete columns on the exterior and outrigger walls, 
connecting the walls to exterior columns at the top.  Some of the core walls have ETABS® Pier labels, and 
the outrigger walls are modelled with shell elements that have ETABS® Spandrel labels.   

The model will be used to demonstrate concrete column, beam and wall design using the Multistory 
Designer for ETABS® application. 

Sample Model-2 Overview 

Below is a brief summary of some of the features contained in the sample model, which are supported by 
the application.  

 

 
Figure 9. 3D model view in ETABS® 2016 
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Figure 10. Plan view of Typical Floor in ETABS® 2016 

 

 
Figure 11. Plan view of Core showing ETABS® Wall Pier and Spandrel Labels 
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Importing the ETABS® Export Data (MDB) into the Multistory Designer Application 

Below is a summary of the steps required to Import the ETABS® MDB into the application.  

First, open Multistory Designer: Select from the S-CONCRETE application (in the main menu), and go to 
Run > S-CONCRETE Multistory Designer. The Import Options window will open, as shown in Figure 12. 

 
Figure 12. Main Import Window 

1. Enter the name of the ETABS® MDB file or select the Ellipse (browse) button to open the ETABS® 
MDB file that was previously Exported. 

2. Filter (by unchecking) the ETABS® objects you want to Import for Concrete Design.  The objects 
initially checked have geometry and forces available. 

3. Filter the elements by Section Name and the Load Combinations to be imported.  (See Figure 13 for 
more details.) 

4. Choose how ETABS® Brace, Wall and Spandrel elements are designated in S-Concrete for design. 
5. Set ETABS® Member Local Axis results to S-Concrete Section Coordinate System.  The defaults should 

work in most cases. 

  

p. 13



Altair S-CONCRETE 2021.1 
MultiStory Designer Reference Guide 

Proprietary Information of Altair Engineering 

Referring to Figure 13, the Filter Options allow the user to select specific ETABS® Section Names, Pier and 
Spandrel Labels, and Load Combinations to be imported for Concrete Design. 

In this example, we choose to filter out the Steel members and some floor framing beams that are not 
relevant at this time in the design. 

The numbers in parentheses after the Section Labels indicate how many elements, of each item, is 
contained in the model.   

  

 

Figure 13. Model and Member Force Filter Options 
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Force Mapping from ETABS® to S-CONCRETE 

1. Select the section of interest to see the mapping options: Columns, Beams or Walls. 
2. Specify the source/forces that come from ETABS® . 
3. User can opt to ignore forces if desired before performing the design. 
4. Option to Flip the sign from positive to negative is available if required by the user. 

 

 

Figure 14. Advanced S CONCRETE Force Mapping Option 

Specifying the Initial Reinforcement 

After the model geometry and analysis forces are imported, the user may now specify the Design Code, 
Bar Type, initial reinforcement percentages, rebar material properties and concrete cover to be used in the 
preliminary evaluation of the members.   

Figure 15 shows the design parameters available for Columns, Beams and Walls.  The parameters specified 
in this screen apply to all elements in the model, so it would be practical to establish the minimum 
reinforcement that you want for all members. In proceeding steps, you will be able to see the initial DCR’s 
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of each the sections, based on maximum forces from the analysis, and then further customize 
reinforcement for members exceeding the preliminary capacity requirements. 

When you have completed specifying the initial concrete design parameters, click the “Apply Design 
Standards to All Sections” button to proceed.  You may come back to this screen, revise the parameters 
and click the button to re-calculate the reinforcement for all members at any time. 

 
Figure 15. Initial Concrete Reinforcement Parameter Specifications 

   

Please Note:  For documentation purposes, this screen shows Column, Beam and 
Wall R/F parameters together.  In the Application, they are on separate Tabs.  
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Reviewing Initial Results and Modifying Reinforcement for Section Groups 

At this point, Multistory Designer has calculated the initial reinforcement for all sections, determined the 
maximum forces from the user’s selected Load Combinations and performed some preliminary capacity 
checks and reported DCR’s (Demand Capacity Ratios).  For Columns and Walls, the DCR’s are calculated 
for axial tension and compression, using simple “short” column formulas.  For Beams, the DCR’s are 
calculated for strong axis bending for the positive and negative moments.  Figure 16 is a screenshot 
example of these results.  Results are also available in tabular form to allow for sorting and Excel exporting 
(via CSV file format) for further review.   

 

 

Figure 16. Concrete Column DCR Summary with User R/F Override Tools 

Looking at Figure 16, as you click each section in the Column Sections list, the Design Summary results 
(Area 1) for that section are displayed, and the parameters in Area 2 are updated for the selected section.   

This screen can be used to override the fields shown in Area 1, for one or more selected sections.  This 
action will force an update of the reinforcement and a re-calculation of the capacities (DCR).  Simply make 
the changes and click the Update button at the bottom of the screen.  Also, use the Update Fields picklist 
at the top of Area 2 to activate checkboxes to allow update of only selected fields for each update 
operation. 

Column Form and Column Table buttons in Area 3 are discussed in the next section. 
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The “Include Stories” feature in Area 4 allows the user to further refine the section design groups that will 
eventually make up the S-Concrete files that are run in the Batch Utility.  By default, the members for all 
ETABS® Stories which contain a unique section size (name) are grouped together in a single S-Concrete 
file.  The “Include Stories” tool allows a user to further subdivide groups of members with the same 
Section Name by one of more ETABS® Stories.  This would allow a user to specify different reinforcement 
requirements for a group of members that have the same cross-section along the height of the building.  
Creating custom groups “By Story” is discussed later in this document. 

 

 

Figure 17. Concrete Beam DCR Summary with User R/F Override Tools 
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Figure 18. Concrete Wall DCR Summary with User R/F Override Tools 

 

Reviewing Initial Results and Modifying Concrete and Reinforcing Data using the Table 

The initial reinforcement data, as well as member capacities calculated via the Form in Figure 15, can be 
displayed in tabular form as partially shown in the screenshot as Figure 19 below.  The output Table 
provides an efficient review of the initial results as well as the ability to override additional concrete 
design parameters that will eventually be used to create the S-CONCRETE files to run the Batch Utility.  
The File Menu “Export Data” option allows for exporting all data to a CSV file which can be opened in 
Microsoft Excel.  While there is no Import to update the values at this time, a user can export or copy to 
Excel, make changes there, and copy and paste data to update the Table.  Also, it should be noted that 
Section cross-section dimensions and material strength parameters can also be edited in the Table, 
overriding those values from the ETABS® model.  After you make any changes to the values in this Table, 
make sure you click the “Apply” button to save them.   

 

Figure 19. Concrete Column Design Data - Table View 
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Reviewing Initial Results and Modifying Concrete and Reinforcing Data using the Form 

The initial reinforcement data, as well as member capacities calculated via the Form in Figure 15, can also 
be displayed in a highly interactive Form, as shown in the screenshot in Figure 20 below.  Only the 
Column Form is shown here, but there are Forms for Beams and Walls with similar features.  This Form 
allows the user to override any of the concrete geometry or reinforcement parameters shown for each 
individual design section in the model.  The Form also has functions to create and open an S-CONCRETE 
file for any given section as well as run the Batch Utility for that section to obtain complete code check 
results available in S-CONCRETE which are displayed at the bottom of the Form. 
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As can be seen from Figure 20, the Concrete Design Data’s Form View is highly interactive. It allows 
the user to customize the geometry and reinforcing data for each individual Design Section in the 
model.  

To edit Section Data in this form, select a Design ID in the drop-down menu in the top-left corner of 
the form.   

Area 1 contains all data fields that can be edited for the Section.  If you change the cross-
section dimensions, concrete/steel strength or the vertical reinforcing parameters, the Axial 
Capacities (DCR) should be re-calculated and the section image updated.  All changes made 
here are stored in the main table and will be used in the S-Concrete Batch file Utility. 

Area 2 has two features that make this Form very powerful.  The “Run Code Check” button 
takes the input data from the Form and creates an S-Concrete file, runs the file in the 
background and reports the results in the Code Check Results area.  This can be used to 
perform quick nearly “real-time” calls to S-Concrete’s Code Check engine to give immediate 
feedback on your design.  The “Run S-CONCRETE” button launches an instance of S-Concrete 
for the active Section with all member forces associated with this section, giving you the 

Figure 20 Concrete Column Design Data - Form View 
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ability to review the results and make quick (what-if) changes on the Section.  Please note, 
any changes made in the S-Concrete session must be manually inputted in the Form to be 
saved for future use. 

Area 3 of Figure 20 is for the confirmation of Field Changes. If you decide to modify any 
property of a particular section or group of sections, then you can use the ‘Apply’ button. It is 
possible to alter values, and either ‘Cancel’ or ‘Apply’ the changes, without closing the form 

 

As shown in Figure 21, the Beams form has the ‘Same Bar Size’ option for top and bottom rebars. 
Users can change the primary row, while the remaining rows will all be updated with the selected 
size. 

 

 

 

  

Figure 21. Beam Design Data - Form View 
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Creating S-CONCRETE Files and Running the S-CONCRETE Batch Utility 

With the Initial Reinforcement set or modified with the functions described above, the next step is to 
Create the S-CONCRETE (SCO) files and run them through the S-CONCRETE Batch Utility to determine the 
Code Check adequacy of the sections using the specified reinforcement.  

 

 

Figure 22. S CONCRETE File Creation and Batch-Run Feature 

 

Area 1 of Figure 22, the SCO File Creator window displays the features that allow users to create S-
CONCRETE (SCO) files for all or specific Columns, Beams and Walls with Loads as chosen by the user.  

The SCO files are created and saved in a directory created by the application based on the original folder 
location of the ETABS® MDB file.  Figure 23 shows the directory and files created for the Columns in this 
model.  Files for each Member Type are stored in separate directories.   

 

Figure 23. S-CONCRETE File Save Directory in User’s Model Folder 
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Area 2 of Figure 22, the SCO File Creator window provides functions to run the S-CONCRETE Batch Utility 
for the SCO files created in Area 1.  The Batch Utility runs in the background and displays a dialog box 
when finished.  The Batch Utility is able to run different Member Types (Columns, Beams and Walls) in 
separate CPU Cores if the computer has a multi-core processor.  This speeds up the overall run-time 
considerably for large models which have a large number of SCO files of each member type. 

The Batch Utility is capable of running in “Code Check” mode, which means it will perform Code Checks 
for each SCO file based on the user’s specified reinforcement and the analysis forces. The “Auto Design” is 
also available. 

When clicking the ‘Run Batch Utility’ command the user can see the following window and options: 

 

Figure 24. Batch Processing and Report Utility Window 

 

Area 1 of Figure 24, navigate and open the generated folder containing the SCO files of interest. The user 
can choose the folder containing all SCO files for either Beams, Columns, or Walls. This example shows a 
total of 35 SCO files. 

Area 2 of Figure 24, you can specify to re-run a batch process for the selected files after deciding to run a 
’Code-Check’ or ‘Auto-Design’ 

Area 3 of Figure 24, specify the directory where the Report will be saved. 
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Area 4 of Figure 24, the user can filter information that is included or excluded in the report. Figure 25 
below, shows the different filters available to the Report before clicking the ‘Create Report’ command. 

 

Figure 25. Available Options to print in the Report 

 

Area 5 of Figure 24, create the PDF report. The report is very similar to the reports generated by S-
CONCRETE, but the Multistory Designer report includes data for multiple concrete sections. Figures 26 & 
27 shows a report example with hyperlinks to navigate throughout the report to find sections of interest 
quickly. 
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Figure 26. Batch Processing Report Example – Column Table of Contents 
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Figure 27. Batch Processing Report Example – A Column Section 
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Reviewing the Results from the S-CONCRETE Batch Utility 

After the S-CONCRETE Batch Utility has been run, a selected portion of the results is read back into the 
application to allow users to review the results without opening S-CONCRETE for the individual files.  
There are three (3) main Tools to review the results, a Table view, PDF Report view, and within the member 
Design Data Form Tool that is shown in Figure 21.   The Table and PDF Reports are available from buttons 
shown in the application dialog in Figure 22.  The Design Data Form will display a limited detail of the 
Batch results. You can return to the main window shown in Figure 15 by using the View Menu and go to 
the Design Standards menu item. 

A sample of the Reports from each of these Tools for Columns is shown below.  The Reports generally 
show a summary of the member cross-section dimensions, input reinforcement, DCR ratios for Shear, 
Torsion and Moment, Warning Messages that would be part of the S-CONCRETE stand-alone application 
Results Report and concrete and steel quantities, per unit length of the member.  

 

 

Figure 28. S CONCRETE Batch Utility Report for Columns – Table View 
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Figure 29. S CONCRETE Batch Utility Report for Columns – PDF Report Tool 
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Figure 30. S CONCRETE Batch Utility Results for Columns – Design Data Form 
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Advanced Feature – Create Section Design/Group Data by using ETABS® Stories 

The screenshots below show the steps to create SCO Files by a custom selection of ETABS® Stories or for 
each Story, for a selected Section in the model.  The same tools are available for Beams and Walls. 

Figure 31 shows how to activate the “Include Stories” feature in the R/F override window of the 
application.  This tool allows a user to leverage the Story attribute, which is part of the ETABS® model to 
create custom SCO files to perform more detailed evaluations using the S-Concrete Batch Utility. 

 

 

Figure 31. Create Section Groups by ETABS® Stories 

 

As shown in Figure 31, users can create a custom design Group by selecting a Section and selecting the 
Stories to be contained in the Group, typing in a Group Name and then clicking the button 
“Create/Update R/F for Selected” to create the new Group.  After the new Group is created, the DCR 
values are updated based on the analysis forces related to the members in this Group, allowing the user 
to update the reinforcement to satisfy the strength requirement for this group.  This Design Group will be 
part of the set of SCO files to be evaluated in the S-CONCRETE Batch Utility.  
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Figure 32. Create Custom Story Groups by Section 

 

Users can select a single section and create individual SCO files for each Story that is associated with the 
ETABS® Section in the model (see Figure 32).  This feature can be used to perform a Story-by-Story 
analysis of the members to determine the required reinforcement needed to satisfy the design. 

 

 

Figure 33. Create Story-by-Story Groups by Section 
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Advanced Feature – Creating HTML Results for each ETABS® Story with Schedule-like Report  

The screenshots below show the steps to create an HTML Report when the SCO Files are created and run 
for each Story in the model, as described in Figure 22 shown above.  The Report generated from this 
option displays the results in a schedule-like format, providing for a detailed review of grouped column, 
beam, or wall stacks. 

To create the Column Report for the Model, edit the Report Tool data, as shown below.  Update the 
Report Filename as desired to make the Report for Columns unique.  Also, edit the 
“SectionNameForGroup” field to allow all columns with Section Names beginning with the letters “RC” to 
be grouped in the Report. 

 

Figure 34. HTML Schedule Report Option for Columns  
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Figure 35. Sample Output HTML Schedule Report for Columns 
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Similarly, to create the Beam Report for the Model, edit the Report Tool data, as shown below.  Update 
the Report Filename as desired to make the Report for Beams unique.  Also, edit the 
“SectionNameForGroup” field to allow all beams with Section Names beginning with the letters “LB”, for 
the Link Beams and “OTR”, for the Outrigger Wall/Beams to be grouped in the Report. 

 

Figure 36. HTML Schedule Report Option for Beams 
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Figure 37. Sample Output HTML Schedule Report for Beams 
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Similarly, to create the Wall Report for the Model, edit the Report Tool data, as shown below.  Update the 
Report Filename as desired to make the Report for Walls unique.  Also, edit the “SectionNameForGroup” 
field to allow all walls with Section Names beginning with the letters that make up the unique wall/pier 
labels in the model so they will be grouped in the Report. 

 

Figure 38. HTML Schedule Report Option for Walls 
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Figure 39. Sample Output HTML Schedule Report for Walls 
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